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Aims 
This booklet aims to equip churches in using Microsoft PowerPoint to enhance 
and enable acts of worship. 
 
For brevity’s sake, there are several assumptions made in this booklet: 

• Basic computer definitions and use, basic formatting skills (list is not 
exhaustive): 

o Definitions: font, copy/paste, text box; 
o Right clicking, dragging, changing font colours/sizes, resizing 

images/text boxes. 

• Readers use Windows rather than Mac/Apple computers; 

• Readers own a laptop, either their own, or a church-owned one; 

• Readers own a projector, TV, or some means of displaying the PowerPoint 
once it has been created. 

• Readers will have/purchase the Microsoft Office PowerPoint that is 
modelled in this booklet, rather than another version. 

• Although this booklet was made using Microsoft Office PowerPoint 2016, 
the principles are the same for older versions, and will be for newer 
versions. Readers will be expected to carry out the steps relevant to their 
version, as it is impossible to cater for all versions in such a simple guide. 

 
If you’re uncomfortable with these assumptions, please get in touch with Dan (see 
end of this booklet) who can help bring you up to this stage. 

Why use PowerPoint? 
PowerPoint can be used effectively to enhance acts of worship. It can also be used 
in meetings/conferences etc., but these uses are not covered in this booklet. 
 
Uses are primarily visual but can also be audible (more on that later!). You can: 

• Show hymn words; 

• Responsive prayers; 

• Place all items of the service on the screen, so everybody knows what is 
next; 

• Show images, perhaps of an event, or an aid to your sermon/talk; 

• Put up flyers/information; 

• Play videos; 
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• Play songs; 

• And much more! 
 
PowerPoint also saves on paper/hymn books etc.! As a church committed to the 
environment, this is a key factor. 

I want to start using PowerPoint… 

Setup 
First of all, you’ll need to purchase, or open/use Microsoft PowerPoint. If you need 
to purchase it, visit your local Curry’s PC World (or similar computer shop). You’ll 
be asking for “Microsoft Office”, this is the package that includes Microsoft 
PowerPoint, amongst many other programs. The PowerPoint logo is on the front 
page of this booklet. Click on this logo to open it.  
 
You’ll be presented with a screen looking something like this: 
 

 
 
You’ll notice the slide (the white rectangle) is quite a lot wider than it is high. This 
is called 16:9 aspect ratio. This is suited for a screen that has that ratio, usually a 
TV. If you’re using a projector, more often than not it’ll be a 4:3 ratio instead.  
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To change the slide to suit your required ratio:  

• Click on Design tab on the top row; 

• Click ‘Slide Size’, a drop down menu will appear;  

• Click ‘Standard’. 
 
To create a new slide: 

• Click on Insert tab; 

• Click ‘New Slide’- NOTE there are two places to click 
o The box around the logo of a slide 

(highlighted in grey above), creates a new 
slide instantly; 

o The drop down menu saying ‘New Slide’, this gives various layout 
options. Have a play around to see the various options. Or you 
could simply go for ‘Blank’. 

• OR; Press CTRL+M on your keyboard. 
 
To duplicate a slide: 

• This is particularly useful if you’ve found a layout you 
like after customising it, or you’re onto the chorus 
again for a hymn!  

• On the column of slides on the left, right click on the 
one you want to copy; 

• Click ‘Copy’; 

• Then click ‘Paste’, there are several options, hover 
over them to see, usually one would require ‘Keep 
Source Formatting’. 

• OR; Press CTRL+C then CTRL+V. 

• You can re-order the slides by click, hold, and dragging them to a new 
spot. 

Creating a Slideshow 
Before the details, remember: 

• Simplicity is everything!  

• Remember that your viewers will be, more than likely, looking at this 
from afar, make sure it stands out! Use simple colour combinations: 

o Black (or dark colour) writing on white background 
o Yellow on blue 
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• NOTE: Some people struggle to read certain colour combinations, or 
some work better for them. Why not ask your congregation if there are 
any they need/prefer? For the rest of us, it’s neither here nor there, so 
why not make it accessible to those who really need it to be so? 

• Bear in mind the time of day. At night (without much artificial lighting) 
consider lighter texts on darker backgrounds, so the prominent 
background is less intrusive. 

• The less that’s happening on each slide the better. Think about 
billboards, or good posters in train stations/bus stops, how much detail 
do they have? 

 
To insert some text: 

• Click on Insert tab; 

• Click ‘Text Box’; 

• Click and drag the text box to fill the area you want. This can be changed 
later and will change based on how much text you put in it.  

• You can change the size/style/font of all the text in the box by clicking on 
the border of the box (it will change from a dashed to solid line), then in 
the Home tab, in the ‘Font’ section, change these things. 

• If you want to change a particular word, or section, not the whole thing. 
Left click and drag over the text with your mouse, and it will highlight the 
text you want. 
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To insert an image: 

• Click on Insert tab; 

• Then, directly below this tab, click ‘Pictures’; 

• Find the picture from your files and double click it to insert it into the 
PowerPoint. If it’s on the wrong slide for you, simply right click on the 
image, click ‘Cut’ (or CTRL + X),, and then click ‘Paste’ (or CTRL + V) onto 
the correct slide. 

• You can resize the picture using the circles in the corners (and along the 
edges) of the image;  

• You can crop the image (take off bits you don’t want) using the crop 
button. In the Picture Format tab; 

• You can rotate the image using the rotate logo on top of the image. 
 

Remember to think sensibly, people need to see the image from far away, make 
it big enough! Not sure? Test it out before the service!  
 
To insert a video: 

• Click on the Insert tab; 

• On the far right of the tab, click ‘Video’; 

• Find the video from your files and double click it to insert it into the 
PowerPoint.  

• Or you can insert a video from online, such as YouTube. NOTE: You will 
need WiFi for this to play. If your church doesn’t have WiFi but wants to 
explore it, get in touch! 

• You can format the video in the same way as described in the image 
section above, you can resize it, rotate it, or crop it.  



8 
 

• Next, you need to consider how, and when, you want it playing.  
o Click on the Playback tab, this will appear when you have clicked 

on the video.  
o Here, you have several options, when clicking the drop-down 

box next to ‘Start’: 

o ‘In click sequence’ will start the video when you next click (or 
press the next arrow key), during the operation of a slideshow; 

o ‘Automatically’ will start the video when you arrive on the slide 
on which the video is located; 

o ‘When clicked on’, will require you to physically click on the  
video in order to play it. 

• There are several other editing options that you may want to look at: 
o ‘Trim Video’ enables you to cut a video, to make it start and end 

at a different point, rather than watching the entire video; 
o You can adjust the volume; 
o ‘Loop until stopped’ will keep playing the video until you say 

otherwise. 
o As with the rest of PowerPoint, plenty of other things you can do 

too, but these are the basics/fundamentals, have a play!  

• Now you need to consider how people are going to hear the video 
(presuming you want them to!) 

o Plug your laptop into a speaker? 
o Plug your laptop into your sound system? 

▪ Don’t have one? Get in touch with Dan! 
o Play it out of the laptop (this won’t be very loud, but in a small 

group and small room, it’s an option!) 
 
To insert an audio track (song, speech etc) 

• Exactly the same as the video, but click audio instead! 

• The formatting and editing options are the same! Except you have the 
option to ‘Play across slides’. Which allows you to advance to the next 
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slide without the audio stopping. Useful if you are, perhaps, doing a 
series of reflective videos. 

 
Animations and Transitions 

• PowerPoint is full of animations and transitions; 

• Animations are for items on a slide, transitions are for between slides 
(from one to another) 

• There is such a variety it would be unhelpful to explain them all, but 
remember the first rule, keep it simple! 

• Animations, particularly in church, can be helpful for things like sermons, 
when the preacher only wants to display one point at a time. 

• But for most services, and most parts, it’s recommended you keep 
animations to an absolute minimum; 

• To use animations, click the Animations tab. To use an animation, you 
need to highlight a bit of text (click and drag), click on a text box, or 
image, or a video/audio clip. Then click the relevant animation, we’d 
recommend only using Appear or Fade; 

• The green animations are the entrances, when you click on one, it will 
demonstrate it briefly; 

• The red animations are exits; 

• The yellow animations are emphases; 

• There are various options in the tab such as delays and length of the 
animation; 

• When using animations as suggested (perhaps for a sermon), the 
‘Animation Pane’ is key, as in this place you can reorder animations by 
clicking and dragging them up or down; 

• You can also get them to work automatically, either starting ‘With 
previous’ or ‘After previous’, or with a delay after the previous etc.  

• To use transitions, click the Transitions tab. You can change the length of 
transitions, or create one to move to the next slide automatically. We’d 
recommend only using the Fade transition; 

• Again, many options, have a play around!  
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Sample Slides 
Here are some sample slides of how your PowerPoint might want to look: 

 
Note that whilst a ‘night’ slide swaps the black-white round, the title is also 
lighter. This will also make it easier to read at night-time. 
 

Tips 
• Keep it simple!  

• Simple fonts, keep animations to a minimum!  

• Try to use big font sizes. Think the font looks big? Go one bigger! No 
smaller than about 40pt. (Test it before the service!) 

• When putting hymns into a PowerPoint, think about pauses (or lack of) 
in the hymn. You probably don’t want to be changing slides when there’s 
no natural pause. Speak to the musician/s if you’re unsure! One slide per 
verse, one per chorus generally works well, but remember font size, you 
may need more than one slide per verse; 

• Note the slides above, PowerPoint automatically capitalises new lines. 
You may not want this, particularly when singing a hymn, to signify that 
this line is continued from the last one! 

• Keep all rows of text left aligned, it helps people follow it line-to-line 
easier. Individual titles can be centre aligned; 

What next? 
When creating PowerPoints for regularly occurring events (e.g. A weekly Sunday 
service), consider copying and pasting ‘standard’ slides into next week’s/next 
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event. It will save you an awful lot of time recreating slides! Even if minor details 
change, at least you can keep the formatting!  
 
There is huge amount more to PowerPoint than that which has been explained in 
this booklet. If you’re feeling brave and wish to explore these avenues, please do 
get in touch! Or, be braver, have a go yourself! If you click the wrong thing, undo 
it (Press CTRL+Z). Remember to keep it simple though!  
 
Practice, practice, practice! It will feel slow at first, following the instructions, then 
doing it without, before it then becomes second nature and speedy. So be patient, 
keep practicing. Everybody has to start somewhere! 
 
If you’re needing to explore projection/display options to display your 
PowerPoint, please get in touch. 
 
If you need any help with what’s been explained in this booklet, would like to know 
more, or if you feel your church would benefit from 1-to-1 training, please get in 
touch. 

Getting in touch 
Dan Morrell 

 
Version 1 

21st April 2020 

dmorrell96@gmail.com  
07773174909 
Media for Ministry Consultant 
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Produced and edited by Dan Morrell on behalf of the United Reformed Church 
Yorkshire Synod, St Paul's St, Morley, Leeds LS27 9EP 


